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Preface

Overview

Purpose
This guide explains how to install and use NetRider Client for Macintosh
software.

Intended Audience
This guide is written for NetRider Client for Macintosh users.

Conventions
This guide uses the following conventions:

Convention Description

boldface text Represents the introduction of a new term or the
name of a button, icon, menu, menu option, or
folder.  Boldface text is also used to show user
input.

numbers Unless otherwise noted, all numbers in the text are
decimal.
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Associated Documents
The following documents provide information about the environment in
which you install NetRider Client for Macintosh software:

• AppleTalk Remote Access Modem Developer’s Guide.  You can obtain
the document from the Apple Programmers and Developers
Association by calling 1 (800) 282-2732 (in the US only) or by sending
AppleLink email to APDA.

• DECserver 700 Site Preparation and Maintenance.  Explains how to
prepare the site before installing the DECserver 700 hardware.

• DECserver 90TL/DECserver 90M Owner’s Manual.  Explains how to
install and operate the DECserver 90TL/DECserver 90M hardware.

• DECserver 900 Installation.  Explains how to install and operate the
DECserver 900 hardware.

• DECserver Network Access Software Installation (MS-DOS,
OpenVMS, OSF/1, ULTRIX, or UNIX).  Explains how to install the
network access software on your operating system.

• Network Access Server Management.  Explains how to perform
management tasks for various Digital access servers.

• Network Access Server Commands.  Describes the command set.

• Network Access Server Problem Solving.  Provides troubleshooting
information.
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Chapter  1
NetRider Client for Macintosh Installation

Overview

Introduction
This chapter explains how install the NetRider Client for Macintosh
software.

In This Chapter
This chapter contains the following information:

• Product overview

• System requirements

• Installing the software

• Next steps
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Product Overview

Introduction
NetRider Client for Macintosh is a client software application that allows
Macintosh users to connect to remote networks through the use of the
Point-to-Point protocol (PPP) .  It is used in conjunction with a
DECserver network access server.  With a modem, users can “dial in” to
a remote network and access both AppleTalk and TCP/IP services
simultaneously.

The software can use all the communication features of the Macintosh,
including the Communication ToolBox and the same Connection Control
Language (CCL) scripts used in Apple’s AppleTalk Remote Access (ARA).
NetRider Client for Macintosh is integrated with the native AppleTalk
protocol stack included with each Macintosh and notifies active
connections when the link is closed down.

Unsupported Utilities
NetRider Client for Macintosh includes some additional utilities and
applications for your convenience, many of which are shareware.  Unless
otherwise specified, Digital Equipment Corporation does not support
these utilities.  If you keep and use shareware for more than a few
weeks, you should pay the appropriate author(s).

ISDN Support
NetRider Client for Macintosh can be used over ISDN lines with the
AT&T 5ESS switch type.



System Requirements

NetRider Client for Macintosh Installation   1–3

System Requirements

Hardware Requirements
To install NetRider Client for Macintosh, you need the following:

• A Macintosh SE or later model.

• A minimum of 1 MB of disk space on the system disk.

• 4 megabytes of Random Access Memory (RAM).

• A Hayes-compatible modem, 9600 baud minimum, and a “hardware
handshaking” modem cable.  A faster modem is recommended for
improved performance.

Software Requirements
To install and use NetRider Client for Macintosh, you need the following:

• One or more installation diskettes labeled Installation Disk.  The
diskette labeled Netscape contains the Netscape World Wide Web
browser.  Its installation is optional.

• Macintosh System 7.1 software or later.

• MacTCP.

If MacTCP is not installed on your Macintosh, NetRider Client for
Macintosh installs it for you automatically.  If MacTCP is already
installed, NetRider Client for Macintosh updates it to its latest
revision, if necessary.

• On the remote network, a Digital network access server running
AppleTalk, IP, or both protocols.

• IP and gateway network addresses and domain name server
information provided by your system or network administrator.
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More Information
For complete information on supported hardware and software, refer to
the Software Product Description (SPD) document supplied with your
kit.
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Installing the Software

Before You Start
Before you begin installation, check that the installation diskette is
write-protected.  Also make sure your Macintosh has the appropriate
system software installed (System 7.1 or later).

Procedure
Do the following to install the software:

Step Action

 1 Do one of the following:

a) If installing from diskette, insert Installation Disk 1 into
a drive and double-click the NetRider Client for Mac
diskette icon.

b) If installing from a file server, double-click the NetRider
Client for Mac folder icon.

The NetRider Client for Mac window appears.

 2 Double-click the NetRider for Mac v1.1 Installer icon.  A
NetRider splash screen appears.
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Step Action

 3 Click Continue.  The release notes appear:

 4 Read the release notes and, if desired, save and/or print them
by clicking the appropriate buttons.

 5 Click Continue when you are finished with the release notes.
An installation dialog box appears:
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Step Action

 6 Do one of the following:

a) Click Install to perform a standard install.

b) Click Custom to perform a custom install and go to step 10.

 7 Click Yes when the next screen appears.

 8 A file dialog box appears:

Specify the folder into which you want to install your software
and click Install.

 9 When a message appears informing you that installation was
successful, click Restart.  Go to step 13.
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Step Action

 10 If you perform a custom install, the following dialog box
appears:

Select the component you want to install by clicking on the
item.  To select more than one component, hold down the
Command key while clicking.  Click Install when finished.

 11 A file dialog box appears:

Specify the folder into which you want to install your software
and click Install.
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Step Action

 12 When a message appears informing you that installation of the
custom item(s) you selected was successful, click Quit if you are
finished.  You may need to restart your Macintosh depending
on which item(s) you custom installed.

13 When you restart the system, check that the following files are
installed in their proper locations.

File(s) Location

NetRider Client for
Mac

NetRider Client for Macintosh folder on
your hard disk.

PPP Init Extensions folder in your System Folder.

PPP Adev Extensions folder in your System Folder.

PPP Mdev Extensions folder in your System Folder.

MacTCP Control
Panel*

Extensions folder in your System Folder.

Generic CCL
scripts**

Extensions folder in your System Folder
(several files).

* MacTCP is installed only if not already present and up-to-date on your system.
**Most users never need the generic CCL scripts because they can use the default
scripts provided with many modems.  Users who want to customize scripts can
refer to Appendix A for detailed information.
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Next Steps

Configure Your Software
Once you have installed the software, you need to configure it.  The table
that follows lists the steps you should take.

Step Described in...

Configure MacTCP Chapter 2

Configure AppleTalk Chapter 2

Create a connection document Chapter 3

Configure modem settings Chapter 3

Configure PPP settings Chapter 3

Configure TCP/IP settings Chapter 3

Save connection document Chapter 3

After you configure the software, you can then make your network
connection as described in Chapter 4.
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Chapter  2
Protocol Configuration

Overview

Introduction
Before you can connect to a remote network, you must configure the
TCP/IP and AppleTalk protocols.

In This Chapter
This chapter contains the following information:

• Configuring MacTCP

• Configuring AppleTalk
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Configuring MacTCP

Before You Configure
Obtain the following information from your system or network
administrator and fill in the blanks accordingly:

• The method of obtaining your IP address.  Find out whether you
must enter your address Manually or whether it is assigned by a
Server automatically:_________________________________________

• The IP address of your Mac, if you enter it manually:____________

• Your gateway address, if required:_____________________________

• The domain name and the IP address of the default domain name
server:_______________________________________________________
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Procedure
Do the following to configure MacTCP:

Step Action

 1 Select Control Panels from the Apple menu.

 2 Double-click the MacTCP icon.  The MacTCP window appears:

 3 Click the TCP/IP PPP icon in the MacTCP window to select it
and enter your IP address in the IP Address field.  For server
addressing, leave this field set to 0.0.0.0.  Selecting TCP/IP PPP
disables the other protocols, which in this example are
EtherTalk and Ethernet.
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Step Action

 4 Click More... to display the MacTCP configuration window:

In steps 5 through 8, use the information you gathered in the
“Before You Configure” section.

 5 In the Obtain Address box, click either Manually or Server.

• Click Manually if you want to set your IP address to the
one you entered in the MacTCP dialog.

• Click Server if you want the remote network to negotiate
your IP address and automatically set MacTCP during each
connection.

• The Dynamically option is not available for NetRider
Client for Macintosh.

 6 Do not change any parameters in the IP Address box.

 7 In the Routing Information box, enter Gateway Address.
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Step Action

 8 In the Domain Name Server Information box, enter the IP
address of your primary name server in the IP Address field
and its associated domain in the Domain Field.  Click the
Default button.

 9 Click OK to save all settings.

 10 Close the MacTCP control panel.

 11 If a screen appears prompting you to restart your Mac to effect
changes, click OK and restart your Mac.

Next Step
If you want to configure an AppleTalk connection, follow the steps in the
Configuring AppleTalk section.
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Configuring AppleTalk

Procedure
Do the following to configure AppleTalk:

Step Action

 1 Select Control Panels from the Apple menu.

 2 Double-click the Network icon to display the Network window:

 3 Click the AppleTalk PPP icon in the Network window to
select it.  A warning appears informing you that changing your
AppleTalk connection interrupts current services and asks
whether you want to change the connection.

 4 Click OK to change your connection to AppleTalk PPP.

 5 Close the Network window.
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Next Steps
Do the following:

Step Action

 1 If you have not already done so, configure your TCP/IP
connection as described in the previous section.

 2 Close the Control Panels window.

 3 Create a connection document as described in Chapter 3.
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Chapter  3
Creating a Connection Document

Overview

Introduction
This chapter explains how to create, save, and edit the connection
document that you use to connect to remote networks.

In This Chapter
This chapter contains the following information and procedures:

• Connection document description

• Open a new connection document

• Specify authentication parameters (optional)

• Provide dial-in information

• Configure modem settings

• Configure PPP settings

• Configure TCP/IP settings

• Saving the connection document

• Editing a connection document
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Connection Document Description

What is a Connection Document?
A connection document is a NetRider Client for Macintosh file you create
for your modem and for the remote network to which you want to
connect.  The file contains preferences information, such as your modem
type and connection type.

NetRider Client for Macintosh uses a connection document to record the
information it needs to connect to the desired remote network.  After you
create, configure, and save a connection document, you can launch
NetRider Client for Macintosh automatically with the recorded settings
by double-clicking the connection document icon.  Chapter 4 contains
more information on making a connection.

Steps to Create a Connection Document
1. Launch NetRider and create a new connection document

2. Specify authentication parameters (optional)

3. Provide dial-in information

4. Configure modem settings

5. Configure PPP settings

6. Configure TCP/IP settings
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Open a New Connection Document

Before You Start
To connect to a remote network using NetRider Client for Macintosh,
you must first create a connection document that configures the PPP
system driver for your modem.  Before you attempt to create the
document, check that your network connections are properly configured,
as described in Chapter 2.

Launch the Application
Launch NetRider Client for Macintosh by double-clicking its icon, or
select New Connection from the File menu if NetRider Client for
Macintosh is already running.

An untitled connection document appears:
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Specify Authentication Parameters (Optional)

About Authentication
NetRider supports two types of authentication called PAP and CHAP.
Your system manager can tell you if authentication is enabled on the
server to which you are connecting and can tell you whether PAP or
CHAP is enabled.  You specify either PAP or CHAP when you configure
your PPP settings (see the Configure PPP Settings section).  The
characteristics of PAP and CHAP are as follows:

Type Description

PAP (Password Authentication
Protocol)

Enables your Macintosh to identify
itself to a remote network.  After
an initial link is established, your
Macintosh sends the remote
network an ID/Password pair in
plain text.  If the remote network
accepts the pair, the connection is
made.  If the remote network does
not accept, the connection is
dropped.

CHAP (Challenge-Handshake
Authentication Protocol)

Enables your Macintosh to identify
itself to a remote network.  After
an initial link is established, the
remote network sends a challenge
that prompts your Macintosh to
calculate a response.  If this
response matches the response
that the remote network
calculates, the connection is made.
If they do not match, the
connection is dropped.  CHAP is
considered more secure than PAP,
because no confidential
information is passed in plain text.
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Note that you specify the type of authentication (PAP or CHAP) when
you configure your PPP settings (see the Configure PPP Settings
section).

Procedure

Step Action

 1 Do one of the following:

a) If you want to connect without authentication, click the No
Authentication button.

b) If you want to require authentication before making a
connection, click the Authenticated User button.  Your
server must support authentication.
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Step Action

 2 If you selected No Authentication, you are finished with the
authentication portion of your connection document.  If you
selected Authenticated User, the connection document
window changes to include Name and Password fields and a
Save my password check box as shown in the following figure:

Do the following:

a) In the Name field, enter your user name for the server
to which you want to connect.

b) In the Password field, enter your user password for
the server.  Your password is masked by dots.

c) Check Save my password to save your password in
the connection document, if this is not a breach of your
site’s security policy.
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Provide Dial-In Information

Introduction
You need to enter dial-in information in the Phone field of an open
connection document.

Procedure

Step Action

 1 In the Phone field of your connection document, enter the
sequence of digits the modem must dial to connect to the server.

 2 Click the Remind me check box to be notified of an idle
connection.  In the minutes field, enter the number of minutes
you want NetRider Client for Macintosh to wait before
displaying a reminder.
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Configure Modem Settings

Introduction
Configure your modem settings as follows:

1. Open the Modem window from an open connection document

2. Select port

3. Select CCL script

4. Select after connect action

5. Select connection type

6. Save configuration

Open Modem Window
Open the Modem window as follows:

Step Action

 1 If the connection document is not already open, open it now
from the File menu.
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Step Action

 2 Select Modem from the Configure menu at the top of the
screen to display the Modem window:

Select Port
From the Port pull-down menu, select the port to which your modem is
attached.

Select CCL Script
From the Modem pull-down menu, select the type of modem you are
using.  The CCL script for your modem automatically appears as the
default in the Modem field.  All CCL scripts located in your Extensions
folder are displayed in the pull-down menu.
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Select After Connect Action
From the After connect pull-down menu, select the action you want
NetRider Client for Macintosh to take after establishing a connection:

Option Description

Start PPP NetRider Client for Macintosh begins the PPP
session after it connects.

Show terminal window NetRider Client for Macintosh displays a
terminal window after it connects.  Your
response at that time will be to press [Enter]
until you see the server’s login banner and
password prompt.

Note that if a login password is defined on the
server, selecting Show terminal window is
the only way to connect to the server.  Select
Show terminal window only if you want to
log in to the server manually and enter the
CONNECT PPP command at the server’s
prompt (the default DECserver prompt is
typically Local>).

Attempt UNIX login After it connects, NetRider Client for Macintosh
displays user name and password prompts for a
UNIX login.  The Modem window changes to
include User name and Password fields.  The
contents of these fields are used to log in to the
UNIX system automatically after a connection
is made.

Attempt Comm Server
login

Automates a connection to your terminal
server.  The Modem window changes to include
User name, Password, Prompt, and
Command fields.



Configure Modem Settings

Creating a Connection Document   3–11

If You Select Attempt UNIX login

If you select Attempt UNIX login, you must also do the following:

Step Action

 1 In the User name field, enter your user name for the server to
which you want to connect.

 2 In the Password field, enter the password associated with your
username.  Note that the password is case-sensitive.

If You Select Attempt Comm Server login

If you select Attempt Comm Server login, you must also do the
following:

Step Action

 1 In the User name field, enter your user name for the server to
which you want to connect.

 2 In the Password field, enter the password associated with your
username.  Note that the password is case-sensitive.

 3 In the Prompt field, enter the prompt characters the server
returns when a connection is made.  Note that the typical
prompt returned by DECserver systems is Local>.

 4 In the Command field, enter the command expected by the
server at the prompt.  Your System Administrator will tell you
what you need to enter in the Prompt and Command fields
for your server.

Modem Speaker
Click to uncheck the Modem Speaker box if you do not want to listen to
your modem’s speaker during a connection attempt.
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Configure Connection Type
Specify a connection type by selecting Manual, Automatic, Constant,
or Direct.  The four options you have and their effects are as follows:

Option Effect

Manual Start and stop the remote network connection manually.
The Modem window displays the Drop idle connection
field.

Automatic Connect to the remote network automatically whenever
there is information to be sent.  The Modem window
displays the Drop idle connection field.

Note that Automatic connection is recommended for use
with the Dial on Demand feature of NetRider Client for
Macintosh (see the “Dial on Demand” section that follows).

Constant Maintain a constant connection to the remote network.
The link immediately redials if a connection is dropped for
any reason.  The Drop idle connection field is hidden.

Direct Specify that no modem is involved and that client and
server are directly connected by a serial line.  The PPP
driver restarts the PPP session immediately if it is
terminated.  The Drop idle connection field is hidden.

The Drop Idle Connection Field

If the Drop idle connection field is present, use it to specify the
number of seconds NetRider Client for Macintosh waits before dropping
an idle connection.

Save Configuration
To save your modem settings, close the Modem window.
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Configure PPP Settings

Introduction
Configure your PPP settings by doing the following:

1. Open the PPP window from an open connection document

2. Select compression

3. Select authentication

4. Select character map

5. Select PPP message size

6. Save configuration

Open PPP Window
Open the PPP window by doing the following:

Step Action

 1 Open the desired connection document from the File menu if
you have not already done so.
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Step Action

 2 Select PPP... from the Configure menu.  The PPP window
appears:

Select Compression

Step Action

 1 Uncheck Protocol Compression if the server to which you
want to connect does not support compression of the PPP
protocol.  Digital’s network access servers support both protocol
field and address field compression.

 2 Uncheck Address Compression if the server to which you
want to connect does not support compression of IP addresses.
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Select Authentication
If you select the Authenticated User option in your connection
document, you also enable the authentication radio buttons in the PPP
window.  If this is the case, select an authentication protocol by clicking
either PAP Authentication or CHAP Authentication.  Your system
manager can tell you what type of authentication, if any, is enabled on
your server.

Set Character Map
Boxes in the Character Map effectively specify the control characters
for XON/XOFF, or software flow control, if enabled by the server.  The
default settings are ^Q and ^S.  Click to check a box and select a control
character.  Or click to uncheck a box and deselect it.  Generally, you do
not need to change the defaults.  Check with your system manager to be
sure.

Select PPP Message Size
In the Maximum Frame Size text field, enter the maximum size of any
single PPP message to be transmitted by your modem (1500 bytes is the
default).

Save Configuration

Step Action

 1 If you want to reset all parameters in the PPP window to their
default settings, click Default Settings.

 2 Close the PPP Configuration window.
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Configure TCP/IP Settings

Introduction
Configure your TCP/IP settings by doing the following:

1. Open the TCP/IP configuration window from an open connection
document

2. Specify IP addresses

3. Specify compresion

4. Select SLIP, if applicable

5. Save configuration

Open TCP/IP Configuration Window
Open the TCP/IP window by doing the following:

Step Action

 1 Open the desired connection document from the File menu (if
you have not already done so).
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Step Action

 2 Select TCP/IP from the Configure menu to display the
TCP/IP window:
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Specify IP Addresses
Do the following to specify your local and remote IP addresses:

Step Action

 1 In the Local IP Address field, enter the IP address of your
Macintosh if you are using manual addressing.

 2 You can leave the Local IP Address and Remote IP Address
fields as 0.0.0.0 if the Server option of the Obtain Address
box is selected in the MacTCP window.

Specify Compression
Uncheck TCP/IP Header Compression if the server to which you
want to connect does not support the compression of headers.

If You Use SLIP
Check Use SLIP Protocol to disable PPP and enable the SLIP protocol
to be used over the modem connection for TCP/IP connections only.  You
cannot use AppleTalk over a SLIP connection.

Saving the Configuration
Do the following to save the configuration:

Step Action

 1 If you want to reset all parameters to their default settings,
click Default Settings box.

 2 Close the TCP/IP window.
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Saving the Connection Document

Procedure
Do the following to close and save the connection document:

Step Action

 1 From the File menu, select Save As...

 2 Give the connection document a name and click Save.

 3 Close the connection document window.

Dial On Demand
You can save your connection document on the desktop, in your
NetRider Client for Mac folder or in your Startup Items folder.  If
you save the document in your Startup Items folder in your System
folder, you can take advantage of NetRider Client for Macintosh’s Dial
on Demand feature.

The Dial on Demand feature, which becomes active as soon as you turn
on your Macintosh, configures PPP at boot time and starts a connection
when you try to access a network service.  You can store only one
connection document in the Startup Items folder at a time.
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Closing Without Saving Settings
Many of the configuration windows do not have Cancel buttons to undo
undesired changes.  If you make changes to the settings of a connection
document that you want to undo, close the document without saving the
changes.  When you reopen the document, the settings are unchanged.

To close a connection document without saving changes, do the
following:

Step Action

 1 Click the close box in the upper left corner of the connection
document window.  Apple’s standard Close dialog appears.

 2 Click No in the Close dialog to indicate that no changes are to
be saved.  The connection document is closed, and no changes
are saved.
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Editing a Connection Document

Introduction
Once you have configured a connection document and saved it, you can
change it.

Procedure
To edit a connection document, do the following:

Step Action

 1 From the File menu, select Open Connection to display
Apple’s standard Open File dialog.

 2 Double-click a configured connection document.  Or select a
connection document and click Open.

 3 Perform whatever edits are necessary.

 4 Select Save or Save As... from the File menu to save your
changes.  Or close the connection document window and click
Yes when asked to save your changes.  Click No if you do not
want to save your changes.
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Chapter  4
Remote Network Connections

Overview

Introduction
This chapter explains how to connect to remote networks using NetRider
Client for Macintosh connection documents and how to monitor
connection activity and check status.

In This Chapter
This chapter describes how to do the following:

• Launch the application

• Display connection status

• View the activity log

• Monitor AppleTalk status
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Launching the Application

Introduction
NetRider Client for Macintosh uses the information in a connection
document to connect to a specified remote network.  If you implemented
the Dial on Demand feature, your connection document is located in your
Startup Items folder.

Note that you can make successful connections only if you already
configured all appropriate parameters for this document as described in
Chapter 3.

Procedure

Step Action

 1 Do one of the following:

a) Select Open Connection from the File menu and choose
the previously configured connection document you want to
use from Apple’s standard Open File dialog.

b) Double-click the icon of a previously configured NetRider
Client for Macintosh connection document.

 2 When the selected document opens, click Connect to establish
a connection to the remote network.  During a connection,
status messages are displayed in the right side of the connection
document window.

 3 If you must drop your modem connection at this point, click
Disconnect.
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Action After Connection
NetRider Client for Macintosh uses the information you entered in the
Modem window to determine the action it takes after your modem
connects to the remote network.

Once you have established a connection, you can then run your
application software.
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Displaying Connection Status

Procedure
Do the following to view status information about your connection:

Step Action

 1 Do one of the following:

a) Select Open Connection from the File menu and choose
the previously configured connection document you want to
open from Apple’s standard Open File dialog.

b) Double-click the icon of a previously configured NetRider
Client for Macintosh connection document.

 2 When the selected document opens, click Connect to establish
a connection to the remote network.

 3 Select Status from the Status menu to display the progress of
your connection.  A Status window appears, such as:
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Step Action

 4 If you must drop your modem connection at this point, click
Disconnect in the Status window.

 5 Click the close box to close the Status window.

Bad Frames
If the percentage of bad frames in or bad frames out in the Status
window is more than 10% of your frames in or frames out, have your
system administrator check your modem for problems.
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Viewing the Activity Log

Introduction
Your activity log is a file that NetRider Client for Macintosh generates to
record the history of each connection the software makes until the next
time you restart your Macintosh.  The information in the log is useful,
for example, to determine where a connection failed or how certain
configuration parameters, such as timeouts, affect your connection.

Procedure
Do the following to display the activity log:

Step Action

 1 Whenever your connection document is open, select Activity
Log from the Status menu to view the Log window.  The
window displays information on the connections you have made
with NetRider Client for Macintosh:
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Step Action

 2 Do any of the following, as needed:

• Use the size box to adjust the window’s size, and use the
scroll bars to view text that does not fit in the window.

• Select Print from the File menu if you want to print the
contents of this activity log.

• Select Save or Save As... from the File menu if you want
to save the contents of this activity log.  Note that if you do
not save your activity log, the information in the log is
erased the next time you restart your Macintosh.

 3 Click the close box to close the Log window.
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Monitoring AppleTalk Status

Introduction
AppleTalk routing must be available for your AppleTalk PPP connection
to work.  Your system administrator knows whether your server
supports AppleTalk routing.

Procedure
Do the following to display AppleTalk status:

Step Action

 1 Open a previously configured connection document and click
Connect in the Connection Document window to connect to the
remote network.

 2 Select AppleTalk from the Configure menu to display the
AppleTalk status window, which contains information about
your address, zone, and server:

 3 Close the AppleTalk window.  The connection document
window reappears.
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Chapter  5
Troubleshooting

Overview

Introduction
This chapter describes error messages and provides troubleshooting information for
NetRider Client for Macintosh software.

In This Chapter
This chapter contains information on the following:

• Connection errors

• Connection status

• CCL scripting errors

• Miscellaneous errors

• Sample problems and solutions
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Connection Errors

Login Failed
Explanation

You tried to login but could not.

User Action

Make sure you entered the correct passwords (using the proper case) and
check the activity log for more possible causes.  Or, to log into the server
manually, select Show terminal window from the After connect pull-
down menu in the Modem window.

Modem Error; Modem Not Responding
Explanation

This can occur for many reasons.  One may be if the modem is used in
rapid succession between applications or connections.  For example, if
the modem is used for five sequential connection attempts when the
destination is busy, or there is a mismatch between actual and specified
modem types.

User Action

Try turning the modem off and then back on, check that it is connected
and configured properly, and then try making the connection again.

No Carrier
Explanation

The remote network that your modem is dialing is not transmitting a
signal.

User Action

Be sure that the correct phone number is entered in the Phone field of
the active connection document window.  If the remote modem does not
respond, or if you still receive the message, make sure that the number
you entered returns a high-pitched squeal when you call from your
telephone.
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No Dial Tone
Explanation

No dial tone is present.

User Action

Check that the modem is plugged in on a valid telephone line.

PPP Not Installed Properly or Application Could Not Find PPP Driver
Explanation

Cannot establish PPP connection.

User Action

Check that your NetRider Client for Macintosh files are in the proper
folders (see Chapter 1) and reboot your Macintosh.

Serial Port Already In Use
Explanation

You tried to use a serial port that was already in use.

User Action

Close the application that is using the same port as your modem.  Or
check that the correct port is selected in the Modem window.

Remote Modem Did Not Answer
Explanation

The remote network that your modem is dialing did not answer and your
connection was dropped.

User Action

Try reconnecting at another time.
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Stalled
Explanation

You may see this message if the modem cable is the wrong type or is not
connected properly.

User Action

Check that the correct cable is properly connected.  Then try making the
connection again.

Timeout; Modem Not Responding
Explanation

The remote network that your modem is dialing did not respond and the
timeout parameter was reached, which caused your connection to be
dropped.

User Action

Try reconnecting at another time.
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Connection Status

Idle Timeout
Explanation

The server did not respond to your machine within the appropriate
amount of time, so the connection was automatically dropped.

User Action

Try making the connection again.

Resetting Modem
Explanation

This message is displayed after a connection is closed or busy.

User Action

Try making the connection again.

The Line Is Busy
Explanation

The line your modem is using to call the remote network is busy.

User Action

Try reconnecting at another time.
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CCL Scripting Errors

Bad Command In Modem CCL Script
Explanation

There is a command in the CCL script that the modem does not
recognize.

User Action

Open your CCL script, make sure all commands are legal, and try the
connection again.

Bad Parameter In Modem CCL Script
Explanation

There is a parameter in the CCL script that the modem does not
recognize.

User Action

Open your CCL script, make sure all parameters are legal, and try the
connection again.

Can Not Open Script Larger Than 32KB
Explanation

Your CCL script is too large for NetRider Client for Macintosh to open.

User Action

Try opening it up in a text editor, such as Apple’s SimpleText, and edit it
down to less than 32K.  Use NetRider Client for Macintosh to open the
script after decreasing the file’s size.
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CCL Script Error
Explanation

There is an error in the CCL script.

User Action

Open your CCL script, make sure all parameters and statements are
legal, and try the connection again.

Error in Modem CCL Script
Explanation

There is an error in the CCL script.

User Action

Open your CCL script, make sure all parameters and statements are
legal, and try the connection again.

No @ANSWER In Modem CCL Script
Explanation

There is no @ANSWER statement in the CCL script you are using.

User Action

Open the script, add the appropriate @ANSWER statement to your
script, and try the connection again.

No @HANGUP In Modem CCL Script
Explanation

There is no @HANGUP statement in the CCL script you are using.

User Action

Open the script, add the appropriate @HANGUP statement to your
script, and try the connection again.
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No @ORIGINATE In Modem CCL Script
Explanation

There is no @ORIGINATE statement in the CCL script you are using.

User Action

Open the script, add the appropriate @ORIGINATE statement to your
script, and try the connection again.

CCL Script Failed to Compile
Explanation

There is text in the CCL script that the script interpreter does not
recognize.

User Action

Open your CCL script, make sure all parameters and statements are
legal, and try the connection again.
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Miscellaneous Errors

Can Not Open Log File Larger Than 32KB
Explanation

Your activity log is too large for NetRider Client for Macintosh to open.

User Action

Reboot the Macintosh to create a new activity log.

No Phone Number
Explanation

There is no phone number entered in the active connection document
window.

User Action

In the Phone field of the active connection document, enter the number
of the remote network you want your modem to call and try making the
connection again.

Target Label Undefined
Explanation

This is caused by CCL script syntax errors.

User Action

Be sure that all matchstr or jump statements reference existing labels.

Terminal Window In Automatic Connection Mode
Explanation

The terminal window may not be used when in automatic connection
mode.

User Action
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Open the Modem window and check whether the Automatic
connection type and Show terminal window options from the After
connect pull-down menu are both selected.  Deselect one of these
options and try making the connection again.

Too Many Pages To Print
Explanation

The CCL script is too long to be printed.

User Action

Try setting your printing parameters to print selected pages or pieces of
the script at a time.
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Sample Problems and Solutions

Cannot Establish a Connection
You have configured your connection document and have clicked its
Connect button but are unable to make a connection with your remote
network.

Solution

There are many reasons why a connection attempt might fail, but here
are two important things to check:

• Make sure you are using a hardware handshaking modem cable.
Most modems sold within the past year will come with one of these,
but check with your modem vendor to be sure.  Pinouts for a
hardware handshaking cable are as follows:

Mac Function RS-232 Function Mac Pin DB-25 Pin

RxD (receive) Receive Data 5 3

TxD (transmit) Transmit Data 3 2

Ground Ground 4 & 8 7

HSKi CTS 2 5

HSKo RTS & DTR 1 4 & 20

GPi CD 7 8

• Make sure you enable CTS/RTS flow control.  Do this by entering an
appropriate command for your modem in the modem initialization
portion of your CCL script.
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Have Connection, But Cannot Launch Application
You made a connection but cannot launch an application that requires
TCP/IP.  The message: “This is not an available IP address” appears.

Solution

Open the MacTCP control panel and check that the TCP/IP PPP icon is
selected.  Click More and make sure that either Server or Manual
addressing mode is selected.  If Manual is selected, make sure that the
address specified in the MacTCP window is not being used by another
person.

Have Connection, But Cannot Get Login Prompt
You have a connection (no IP or AppleTalk negotiated), but you cannot
get a login prompt from the server.

Solution

Check that your CCL script is setting your modem port to a baud rate
appropriate for the DECserver to which you are trying to connect.  Also,
check to see if the DECserver is in dedicated PPP mode.  If it is, open the
Modem window and make sure start PPP is selected in the After
connect pulldown menu.

Applications Requiring IP Services Do Not Run
You made a successful connection to a remote network, but you cannot
get applications requiring IP services to work.  You receive error
messages that indicate that someone else is using this IP address, the
MacTCP drivers are not loaded properly, or that it could not get this
address.

Solution

This may indicate a problem with MacTCP.  Open your activity log and
look for the IP address that was negotiated.  Make sure this address is
the same as the address in the MacTCP configuration window.  If the
two addresses are different, you may need to reconfigure MacTCP.
Reconfigure MacTCP, reboot your Macintosh for any configuration
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changes to take effect, and try another NetRider Client for Macintosh
connection.

Cannot Open Connection Document
Every time you try to open a connection document that is in the Startup
Items folder, the application quits.

Solution

This is a result of the Dial on Demand feature.  NetRider Client for
Macintosh cannot tell whether the machine was just restarted or not.
Move the connection document out of the Startup Items folder, modify
it, and then move it back into the Startup Items folder.

Automatic Connect Timing Out
When you have a connection document set to Automatic and launch an
application that requires an IP address, the application times out.

Solution

The time it takes for the driver to call the server and connect is usually
longer then the application using the address is willing to wait.  Once
the connection is made and the status is displayed in the connection
document window, try the application again.

Zones and Services Not Visible
You have an AppleTalk connection up but cannot see any zones or
services.

Solution

Make sure AppleTalk PPP is selected in the Network control panel.
Also, make sure an AppleTalk router is available on the network to
which you want to connect.  Use the remote DECserver’s SHOW
APPLETALK command to verify proper AppleTalk operation.
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Activity Log Does Not Print
You want to print your activity log, but when you select Print from the
File menu, nothing happens.

Solution

Go to the Chooser and be sure that you have a printer selected.
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Appendix  A
CCL Scripts

Overview

Introduction
This appendix briefly explains how to modify and create Connection
Control Language (CCL) scripts.  For more detailed information, consult
the AppleTalk Remote Access Modem Developer’s Guide.  You can obtain
the Guide from the Apple Programmers and Developers Association by
calling 1 (800) 282-2732 (in the US only) or sending AppleLink electronic
mail to APDA.

In This Chapter
This chapter contains the following information:

•  CCL Script Description •  Serial Port Commands

•  Modifying Scripts •  Script Flow Control Commands

•  Creating Scripts •  Iteration Commands

•  CCL Strings •  User Notification Commands

•  CCL Statements •  Pattern Matching Commands
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CCL Script Description

What is a CCL Script?
The Connection Control Language is used to write modem scripts.  Each
type of modem requires a modem script to send commands from the
Macintosh to the modem.

CCL scripts are text files designed to dial and answer particular modems
and are usually provided by your modem vendor.  They can be
exchanged between machines, and they can be printed.  Check your
modem installation diskettes to determine which CCL script you need.

NetRider Supplied Scripts
NetRider Client for Macintosh includes several scripts to control
different kind of modems.  These scripts appear in a menu in the
Modem window when you configure your connection.  Choose the script
whose name most closely matches the product name of the modem.  If
you fail to get a connection with this particular script, you can try one of
several generic scripts.  Designed for Hayes-compatible modems that
operate at 57600, 38400, and 9600 baud, these scripts should work with
most available high-speed modems.  If none of the scripts work, speak to
your service provider or system administrator.

How Scripts Work
CCL scripts execute in one of three possible modes: originate, answer, or
hangup.  Each mode has a separate entry point.  When a call is initiated,
the script runs in originate mode.  When call answering is enabled, the
script runs in answer mode.  When terminating a connection, the script
runs in hangup mode.  Note that because NetRider Client for Macintosh
does not answer calls, the answer mode does not apply.  Information
regarding the answer mode, such as @ANSWER, is provided for
technical accuracy and compatibility with AppleTalk Remote Access CCL
scripts.
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_________________________ Note _________________________

The sections that follow describe the creation and modification of
CCL scripts using NetRider’s interface.  However, any text editor
can be used.
___________________________________________________________
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Modifying Scripts

Introduction
Because NetRider Client for Macintosh and your modem manufacturer
provide default CCL modem scripts, there is usually no need to modify
CCL scripts.  However, if no script is provided for your particular
modem, or if you have special requirements, you can modify a default
script or create a new one using the information in this appendix and in
the AppleTalk Remote Access Modem Developer’s Guide.

Procedure
Do the following to modify a CCL script:

Step Action

 1 Select Open CCL Script from the File menu to display Apple’s
standard Open File with a list of available CCL scripts:
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Step Action

 2 Select a CCL script and click Open to open it.  Click Cancel to
close the window without opening a CCL script.  A window
similar to the following appears:

 3 Edit the text, using the Cut, Copy, and Paste commands of
the Edit menu as appropriate.

 4 If you want to print a CCL script, open the script and select
Print from the File menu.
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Creating Scripts

Introduction
If neither NetRider Client for Macintosh nor your modem manufacturer
provides a CCL script for the modem you are using, you can create a
script using the information in the following sections and in the
AppleTalk Remote Access Modem Developer’s Guide.

Procedure
Do the following to create a new CCL script:

Step Action

 1 Select New CCL from the File menu.

 2 When you see the standard text editing window labeled
Untitled, use the conventions in the sections that follow to enter
the text.  Use Edit menu commands as necessary.

 3 Select Save from the File menu to save the CCL script.

 4 Name the CCL script, select the location where it is to be saved,
and click Save.  Click Cancel to close the window without
saving the script.  The name of the CCL script is displayed at
the top of the window.

Using the New Script

To use the script you have created in a connection document, select the
script from the pop-up menu in the Modem window.
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CCL Strings

What Are Strings?
Strings are groups of characters used in CCL scripts.  They are enclosed
in quotes (" ").  A varString contains parameters for modem setup, such
as the phone number to dial and speaker setting while dialing.  Defined
varStrings are the following:

varString 1 phone number

varString 2 modem “speaker on” flag

Special Characters

The following special characters are allowed within strings:

\13 substitutes a carriage return (hex 0D) into the string

\00 substitutes a null character (hex 00) into the string

\\ substitutes the \ character (hex 53) into the string.

\^ substitutes the ^ character into the string

\" substitutes the " character into the string

^1 substitutes the phone number into the string

^* substitutes the ASK string into the string

The ^ character is used to reference a varString to substitute into the
string.
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CCL Statements

What are CCL Statements?
CCL statements are the elements of a CCL script.  There is one CCL
statement per line of a script, which is stored as a text file.  A CCL
statement can be a label, a comment, or a command.

CCL Labels
Labels begin with an at sign (@)  and continue until the end of the line.
They denote a point in the script that is the target of a jump from
another part of the script.  There are two kinds of labels: symbolic and
numeric.  Symbolic labels contain the at sign followed by a word.
Numeric labels contain the at sign followed by a number.

Labels can be one of the following keywords or a label of the form
@number, which references a numeric label in the script.  You can then
reference this label from other script commands such as JUMP, JSR, and
IFTRIES.  A script can have up to 128 labels, numbered 1 through 128.
To specify label 30, include the command @LABEL 30 in the script.

Label Description

@ANSWER Marks the point in the script where execution begins in
answer mode.

@HANGUP Marks the point in the script where execution begins in
hangup mode.

@ORIGINATE Marks the point in the script where execution begins in
originate mode.

CCL Comments
CCL comments begin with an exclamation mark (!) and continue until
the end of the line.
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CCL Commands
CCL commands start with a word (the command name) and are followed
by arguments on the rest of the line.  Blank lines are ignored.  There are
five categories of CCL commands:

• Serial Port Control Commands

• Script Flow Control Commands

• Iteration Commands

• User Notification Commands

• Pattern Matching Commands
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Serial Port Commands

DTRCLEAR
Clears the DTR (Data Terminal Ready) signal on the RS-232 interface.

DTRSET
Sets the DTR signal on the RS-232 interface.

FLUSH
Empties all characters from the serial input buffer.

HSRESET
Sets the serial flow control options.  Note that the PPP protocol ignores
XON/XOFF because it is unable to process these characters.  The options
are provided to ensure backward compatibility with AppleTalk Remote
Access CCL scripts.

Syntax

Use the following syntax for the HSRESET command:

HSRESET outputXON/XOFF outputCTS XON XOFF inputXON/XOFF inputDTR

Parameters

The following table lists the parameters for the HSRESET command:

Parameter Value Function

outputXON/XOFF 0
1

Disables XON/XOFF handshaking for output.
Enables XON/XOFF handshaking for output.

outputCTS 0

1

Disables CTS hardware handshaking for
output.
Disables CTS hardware handshaking for
output.
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Parameter Value Function

XON 0
1

Disables the XON character
Enables the XON character

XOFF 0
1

Disables the XOFF Character
Enables the XOFF Character

input XON/XOFF 0
1

Disables XON/XOFF handshaking for input.
Enables XON/XOFF handshaking for input.

input DTR 0

1

Disables DTR hardware handshaking for
input.
Disables DTR hardware handshaking for
input.

Enabling CTS Hardware Handshaking

To enable CTS hardware handshaking for output, you would use the
following command: HSRESET 0 1 0 0 0 0 .  You must specify values
for all command parameters.

LBREAK
Generates a long break (3.5 seconds) on the serial output.

SBREAK
Generates a short break (233 milliseconds) on the serial output.

SERRESET
Configures the serial driver, providing values for baud rate, parity,
databits, and stop bits.  Specifying a zero value for any of the parameters
causes the default value to be used.

Syntax

Use the following syntax for the SERRESET command:

SERRESET baudRate parity dataBits stopBits
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Parameters

The following table lists the parameters for the SERRESET command:

Parameter Values Allowed

baudRate 300, 1200, 2400, 4800, 9600 (default), 19200, 38400, or
57600

parity 1 for odd parity, 2 for even parity, 3 for no parity (default)

dataBits 5, 6, 7, or 8 (default)

stopBits 1 for 1 stop bit (default), 2 for 2 stop bits, 3 for 1.5 stop
bits

To specify 9600 baud, no parity, 8 databits, and 1 stop bit, use the
following command: SERRESET 9600, 3, 8, 1 .  Note that proper
operation of PPP requires 8 databits, no parity, and 1 stop bit.

SETSPEED
Sets the asynchronous serial interface speed to the specified speed.  Use
SETSPEED to set speeds other than those allowed in SERRESET.  For
example, to set the speed to 14400, use the following command:
SETSPEED 14400.

WRITE
Writes the specified message, a quoted string, to the serial driver.  For
example, the following command sends the message variable string 1
and carriage return to the serial driver: WRITE "ATDT^1\13".
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Script Flow Control Commands

EXIT
Terminates execution of the script and returns a result.  If the script
completes successfully, the result returned is zero.  If the script fails for
any reason, the result returned is a CCL error code.  You can specify a
desired error code.  For example, the command EXIT -6022 causes the
script to exit and return the error result code -6022 if a busy signal is
encountered.  The following table summarizes error codes.

Code Meaning

-6007 There is at least one script open.

-6008 The script was canceled.

-6009 The script contains too many lines.

-6010 The script contains too many characters.

-6011 The script was not initialized.

-6012 There is a cancel in progress.

-6014 There was an exit with no error.

-6015 There is a label that is out of range.

-6016 There was a bad command.

-6017 The end of the script was reached with no Exit found.

-6018 The match string index is out of bounds.

-6019 There was a modem error and the modem is not responding.

-6020 There is no dial tone.

-6021 There is no carrier.

-6022 The line is busy.

-6023 There is no answer.
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JSR
Causes script execution to jump to the subroutine specified by the label,
saving the address of the line following the JSR command.  At a
RETURN command, execution resumes at the line following the JSR
command.

You can specify the label at which execution continues.  For example, the
command JSR 50 specifies that execution continues at the subroutine
marked by label 50.

JUMP
Causes script execution to continue at the specified label.  You can
specify the label at which execution continues.  For example, the
command JUMP 60 specifies that execution continues at label 60.

IFANSWER
Causes execution to continue at the specified label, if the script is
running in answer mode.  You can specify the label at which execution
continues.  For example, the command IFANSWER 20 specifies that
execution continues at label 20.

IFORIGINATE
Causes execution to continue at the specified label, if the script is
running in originate mode.  You can specify the label at which execution
continues.  For example, the command IFORIGINATE 20 specifies that
execution continues at label 20.

IFSTR
Compares two strings.  If the strings are equal, the script continues
execution at the specified label.

Syntax

Use the following syntax for the IFSTR command:

IFSTR varStringIndex jumplabel compareString
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Parameters

The following table lists the parameters for the IFSTR command:

Parameter Value

varStringIndex Index of the varString with which
to compare.

jumplabel Label to jump to, where execution
continues.

compareString String with which to compare the
varStringIndex string

To specify that execution should jump to label X if the modem speaker on
flag equals 1, use the following command: IFSTR 2 X "1".

PAUSE
Causes script execution to stop for a specified period of time.  You specify
the time to pause in tenths of a second.  For example, the following
command causes script execution to pause for 2 seconds: PAUSE 20.

RETURN
Terminates a subroutine.  Script execution continues with the line
following the last JSR command executed.
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Iteration Commands

DECTRIES
Decrements the internal try counter by one.

IFTRIES
Compares a parameter with the internal try counter.  If they are equal,
the script continues execution at the specified label.

Syntax

Use the following syntax for the IFTRIES command:

IFTRIES numTries jumplabel

Parameters

The following table lists the parameters for the IFTRIES command:

Parameter Value

numTries Number to compare against the internal try counter.

jumplabel Label to jump to, where execution continues.

To check whether the internal try counter is 7, and if so jump to label 80,
use the following command: IFTRIES 7 80.

INCTRIES
Increments the internal try counter by one.

SETTRIES
Initializes the internal try counter to the specified value.  To set the
number of tries to 3, use the following command:
SETTRIES 3.
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User Notification Commands

ASK
Displays a dialog to obtain information from the user when the script is
initialized.  You may need the ASK command if your telephone system
uses special telecommunications equipment.

Syntax

Use the following syntax for the ASK command:

ASK maskflag "message"

Parameters

The following table lists the parameters for the ASK command:

Parameter Value

maskflag 1 or true indicates that the user’s input is masked with
dots; 0 or false indicates that the user’s input is displayed
as normal text.

message Prompt displayed in the dialog for the user.

For example, to prompt the user for a password, try the following
command: ASK true "Enter your password".

NOTE
Sends messages to the internal activity log.  Optionally, you can set the
message level to specify where the message should appear.

Syntax

Use the following syntax for the NOTE command:

NOTE msgStr msgLevel
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Parameters

The following table lists the parameters for the NOTE command:

Parameter Value

msgStr Message string

msgLevel 1 sends the message to the activity log only.

2 sends the message to the Status window only (default).

3 sends the message to the activity log and Status window.

For example, to send the message "Dialing" to the activity log only, you
would use the following command:
NOTE "Dialing ^1".

USERHOOK
Causes the script to perform a special action.  USERHOOK passes an
opcode parameter (1 or 99) to the internal hook, so this hook can perform
more than one function.  Specifying USERHOOK 1 marks a connection
as active when a call is answered and a ring is indicated by the modem.
Specifying USERHOOK 99 causes a terminal window to be displayed.
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Pattern Matching Commands

MATCHCLR
Clears all match strings.  The CCL interpreter has an internal buffer
that holds up to 16 strings identified with the MATCHSTR command.
The buffer holds this information until it is erased with a MATCHCLR
command.  You should use MATCHCLR at the beginning of every
modem script to clear the buffer.

MATCHREAD
Reads input from the serial driver and compares the input to the current
match strings.  If a match is found in the specified time, execution
continues at the label of the matching match string.  Specify the time
allowed for a match in tenths of a second.  For example, the following
command searches for a match within 4 seconds: MATCHREAD 40.

MATCHSTR
Specifies a string to match incoming characters against.  If a stream of
consecutive incoming characters matches the string, script execution
continues at the specified label.  Sixteen possible match strings exist.

Syntax

Use the following syntax for the MATCHSTR command:

MATCHSTR matchNum matchlabel matchStr

Parameters

The following table lists the parameters for the MATCHSTR command:

Parameter Value

matchNum 1 to 32

matchlabel Label to jump to, where execution continues.

matchStr A string (1-255 characters) against which to compare.
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Use the following command to match the string "OK\13\10" with match
string 1: MATCHSTR 1 8 "OK\13\10".  If the strings match, execution
jumps to label 8.
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Glossary

activity log

A file that NetRider Client for Macintosh generates to record each
connection NetRider Client for Macintosh makes until the next time
your Macintosh is restarted.

answer mode

One of three executions of a CCL script.  When call answering is
enabled, the script is in answer mode.  See hangup mode, originate
mode.

AppleShare

An application developed by Apple Computer, Inc. that gives a
Macintosh the ability to function as a file server.

AppleTalk

A multimedia network architecture developed by Apple Computer, Inc.
for use on Macintosh and other computers and peripherals.

asynchronous transmission

A form of data transmission, used mostly by modems, that sends
information a single character at a time, with variable time intervals
between characters.

ATCP

AppleTalk Control Protocol.
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authentication

A process used to verify a piece of data.  In NetRider Client for
Macintosh, authentication describes the process of authorizing users to
connect to remote networks.  See CHAP, PAP.

baud

A term used to refer to the number of characters transmitted per second,
measured in bits per second (bps).

boot disk

See startup disk.

CCL (Connection Control Language)

A computer language used to write modem scripts necessary to establish
connections.

CCL script

A file written in the Connection Control Language that contains
information, such as commands, necessary to connect your modem to the
remote network.  See CCL.

Challenge-Handshake Authentication Protocol

See CHAP.

CHAP (Challenge-Handshake Authentication Protocol)

A protocol that provides a way for a machine (the client) to identify itself
to a remote network (the server).

After an initial link is established, the server sends a challenge that
prompts the client to calculate a response.  If the client's response
matches the response that the server calculated, the connection is
established.

If the two do not match, the connection is terminated.  This protocol is
considered more secure than the Password Authentication Protocol
(PAP) because no confidential information is passed in plain text from
the client.  See PAP.



Glossary–3

character

Any symbol that has a widely understood meaning and can convey
information.  Some characters (such as letters, nmbers, and punctuation)
can be displayed on the monitor and printed on a printer.

character map

An option in NetRider Client for Macintosh that allows users to
substitute characters that cannot be transmitted through the modem
with characters that the remote network recognizes and replaces with
the correct characters once the information has passed successfully over
the link.

checkbox

A small box associated with an option in a dialog.  When you click the
checkbox, you change the option or affect related options.

Chooser

An Apple Menu item that allows the user to select printers, file servers,
or network devices.

client

A program or machine that requests services from a network or server.

client-server

The relationship between hosts on a network where the client is the
originator of a request and the server is the responder.

comm server (communications server)

A device that connects a local area network to a wide area network or
telecommunications network.  In NetRider Client for Macintosh, the
comm server is a Digital network access server that connects the local
area network to your Macintosh.

command

A type of statement found in CCL scripts that begins with a word (the
command name) and is followed with arguments on the remainder of the
line.  See CCL script, comment, label, statement.
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comment

A type of statement found in CCL scripts that begins with an
exclamation mark (!)  and continues until the end of the line.

connection

An association that is established between machines to convey
information.

Connection Control Language

See CCL.

connection document

A NetRider Client for Macintosh file created and configured for
particular modems and remote networks.  NetRider Client for Macintosh
uses these files to record preferences and information such as IP
addresses and modem types.

Dial on Demand

A feature in NetRider Client for Macintosh that is implemented by
placing a previously configured connection document into the Startup
Items folder in your System Folder.  This action configures PPP at boot
time and begins a connection when you attempt to access a network
service.

Domain Name Server (DNS)

An on-line distributed database responsible for mapping host names to
their respective IP addresses.  Also referred to as the Domain Naming
System.

driver

Software that links a standard operating system interface and a
peripheral device.

DTR

Data Terminal Ready.
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flow control

The process that determines the rate at which information is transferred
from one device to another.  Also called handshake.

handshake

See flow control.

hangup mode

One of three executions of a CCL script.  When terminating a connection,
the script is run in hangup mode.  See answer mode, originate mode.

INIT (Initiate)

A routine that is run when your Macintosh is started or restarted.  Often
memory resident, INITs are used to load and activate drivers and system
routines.

IP (Internet Protocol)

See TCP/IP.

IP address

The 32-bit address assigned to a host communicating over the Internet
using TCP/IP.  It consists of a network address and the host’s address.
Also called an email address.

IPCP

Internet Protocol Control Protocol.

label

A type of statement found in CCL scripts that begins with an at sign (@)
and continues until the end of the line.  See CCL script.

MacTCP

A software driver written by Apple Computer, Inc. for the Macintosh
Operating System that implements many TCP/IP protocols.
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modem (modulator/demodulator)

A device that converts serial digital data from a transmitting terminal to
a signal suitable for transmission over telephone lines.  The modem also
converts the telephone signal (analog) into a serial digital signal for use
by another computer or terminal.

modem port

An interface on the back of the computer that is suitable for modem
connection.

modem speaker

The speaker located in a modem that allows you to hear the signals
involved in the connection, that is, the high-pitched squeal.

opcode (operation code)

The basic, low-level instructions that control the actions a computer is to
take.

NCSA

National Center for Supercomputing Applications.

originate mode

One of three executions of a CCL script.  When a call is initiated, the
script is run in originate mode.  See hangup mode, answer mode.

PAP (Password Authentication Protocol)

A protocol that provides your Macintosh (the client) a way to identify
itself to the remote network (the server).  After an initial link is
established, the client sends the server an ID/Password pair in plain
text.  If the server recognizes the pair, the connection is established.  If it
does not accept the pair, the connection is terminated.  See CHAP.

parity

The evaluation of the quality of similarity or equivalence used as a
method for error checking.

Password Authentication Protocol

See PAP.
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PPP (Point-to-Point Protocol)

A standard that allows multiple LAN protocols to be used simultaneously
over a modem line or other serial connection.  Using PPP, the same
connection that provides connectivity for one protocol can be used to
provide connectivity for multiple protocols.  Since PPP is a standard, the
same manufacturer's equipment or software is no longer necessary for
both ends of the connection.  PPP can be used for single user dial-in or
for LAN-to-LAN connections.

Serial Line Internet Protocol

See SLIP.

serial port

The connector for a peripheral device that uses a serial interface,
commonly a modem.

server

A machine or program designed to provide a service to a network.  A
server communicates with a client to handle the client's input and
output needs.

SLIP (Serial Line Internet Protocol)

A specification for using the Internet protocol over a low-speed
asynchronous serial line.

statement

A line found in CCL scripts that is a command, comment, or label.  See
CCL script.

string

A data structure consisting of a sequence of characters, usually user-
readable text.

stop bit

A bit that signals the end of a character in asynchronous transmission.

TCP/IP (Transmission Control Protocol/Internet Protocol)
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Two communication protocols used to connect dissimilar systems.  The
IP protocol controls routing data, and the TCP protocol controls
transferring data.

varString

A string that contains parameters for modem setup, such as the phone
number and whether the modem’s speaker is on or off during dialing.

XON/XOFF (Transmitter On/Transmitter Off)

A method of inband flow control used when a computer is sending
information to a slower device.  Printers often use XON/XOFF
handshaking.  When the buffer is almost full, XOFF (Control S or ^S) is
sent to the host, which suspends output until the printer, or other
attached device, sends an XON (Control Q or ^Q).  See flow control.
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